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To	add	indicator	to	MT4	mobile	you	need	to	do	these	steps:	#1	step	–	position	yourself	on	the	chart	of	desired	symbol	#2	step	–	click	ƒ	sign	in	the	top	right	corner	of	your	mobile	screen	#3	step	–	in	the	list	of	indicators	you	need	to	select	which	indicator	to	add	to	the	chart	#4	step	–	then	you	need	enter	settings	for	that	indicator	if	it	is	needed	#5	step	–
and	then	click	on	the	DONE	button	in	the	right	corner	of	your	screen	Now	I	will	show	you	a	more	detailed	guide	on	how	to	add	trading	indicator	and	I	will	show	you	examples	with	few	indicators.	On	the	chart	in	the	upper	right	corner	of	your	mobile	screen	you	will	see	ƒ	sign.	That	sign	represents	an	indicator	menu	with	indicators	that	can	be	added	to
the	MT4	mobile.	When	you	enter	the	indicator	menu	on	MT4	mobile	then	you	can	select	which	indicator	you	want	to	have.	If	the	indicators	have	settings	that	must	be	set	up	before	placing	it	on	the	chart	you	will	need	to	enter	them	or	use	general	settings.	In	this	example	I	will	use	the	moving	average	to	show	you	how	to	add	an	indicator	to	the	chart.
When	you	are	done	with	settings	click	on	the	DONE	button	in	the	upper	right	corner	of	your	MT4	mobile	application.	And	that	is	all.	You	will	see	your	indicator	on	the	chart	directly.	It	can	be	in	a	separate	window	below	or	on	the	chart	with	candlesticks.	That	depends	on	the	indicator	you	use.	Now	I	will	show	you	an	example	how	to	add	one	of	the
indicators	to	MT4	mobile.	Process	of	adding	EMA	is	the	same	as	the	above	explained	when	adding	SMA.	You	need	to	position	yourself	on	the	chart.	Click	on	the	ƒ	sign	in	the	top	right	corner	and	a	new	menu	will	appear.	Here	you	can	select	which	indicator	you	want	to	add.	From	the	list	select	Moving	Average.	Now	you	have	a	window	with	settings	for
the	moving	average.	You	need	to	select	the	exponential	moving	average	from	the	drop	down	menu.	Drop	down	menu	is	under	the	Method	option	where	you	can	select	other	types	of	moving	average.	When	you	are	done	putting	all	desired	settings	on	the	EMA	you	need	to	click	on	the	DONE	button	in	the	top	right	corner.	That	way	you	will	confirm
selected	settings	and	you	will	add	EMA	to	MT4	mobile.	Below	is	the	image	with	the	EMA	indicator	on	the	MT4	chart.	You	can	see	the	red	line	which	represents	the	EMA	indicator.	Add	RSI	indicator	on	MT4	mobile	is	simply	with	few	steps	and	those	are:	#1	Step	–	go	to	indicator	menu	by	clicking	ƒ	sign	on	the	chart	You	will	enter	an	indicator	menu
where	you	will	have	a	list	of	current	indicators	on	your	chart.	Currently	I	have	an	EMA	indicator	which	is	listed	under	Moving	Average	indicator	like	on	the	image	below.	#2	Step	–	by	clicking	ƒ+	sign	you	will	enter	into	the	indicators	list.	Go	down	to	Oscillators	where	RSI	is	located.	Select	RSI	indicator	and	new	menu	will	show	up	#3	Step	–	select
desired	settings	for	the	RSI	indicator	and	when	you	are	done	click	on	the	DONE	button	#4	Step	–	And	that	is	it.	You	have	an	RSI	indicator	on	MT4	mobile.	The	RSI	indicator	is	below	the	chart	in	a	separate	window.	As	in	the	desktop	version	of	MT4	RSI	has	separate	window	for	easier	using	of	indicator	Add	MACD	indicator	on	MT4	mobile	is	simply	with
few	steps	and	those	are:	#1	Step	–	go	to	indicator	menu	by	clicking	ƒ	sign	on	the	chart	You	will	enter	an	indicator	menu	where	you	will	have	a	list	of	current	indicators	on	your	chart.	Currently	I	have	an	EMA	and	RSI	indicator.	#2	Step	–	by	clicking	ƒ+	sign	you	will	enter	into	the	indicators	list.	Go	down	to	Oscillators	where	MACD	is	located.	Select
MACD	indicator	and	new	menu	will	show	up	#3	Step	–	select	desired	settings	for	the	MACD	indicator	and	when	you	are	done	click	on	the	DONE	button	#4	Step	–	And	that	is	it.	You	have	a	MACD	indicator	on	MT4	mobile.	MACD	indicator	is	below	the	chart	and	RSI	in	a	separate	window.	As	in	the	desktop	version	of	MT4	MACD	has	a	separate	window
for	easier	use	of	indicators.	But	there	is	an	option	to	have	MACD	in	the	same	window	as	RSI.	This	option	I	have	shown	in	the	video	which	you	can	find	at	the	start	of	this	article.	To	modify	indicator	on	MT4	mobile	you	need	to	take	these	steps:	#1	Step	–	go	to	the	menu	where	all	indicators	on	the	chart	are	listed.	That	is	done	by	clicking		ƒ	sign	on	the
chart	and	you	I	get	menu	with	three	indicators	which	I	have	on	the	chart	#2	Step	–	select	which	indicator	you	want	to	modify.	I	will	select	the	RSI	indicator	and	the	settings	menu	for	the	RSI	will	show	up.	In	this	menu	change	what	you	want	and	confirm	changes	by	clicking	DONE	button	And	that	is	it.	If	you	want	to	change	any	other	indicator	settings
simply	repeat	the	same	steps	as	described	above.	To	remove	indicators	from	the	MT4	mobile	you	need	to	take	these	steps:	#1	step	–	position	yourself	on	the	chart	of	desired	symbol	#2	step	–	click	ƒ	sign	in	the	top	right	corner	of	your	mobile	screen	and	you	will	get	a	list	of	all	indicators	on	your	chart	#3	step	–	In	the	top	right	corner	click	on
the	Trash	icon	and	new	option	will	show	#4	step	–	click	on	the	checkbox	next	to	each	indicator	you	want	to	remove	#5	step	–	confirm	your	selection	by	clicking	on	the	Trash	icon	in	the	top	right	corner	And	that	is	it.	You	will	remove	those	indicators	from	the	chart	and	you	will	have	only	one	indicator	left.	I	will	use	an	image	where	I	have	all	three
indicators	on	the	MT4	mobile	and	I	will	remove	the	RSI	and	MACD	indicator.	When	you	click	ƒ	sign	in	the	top	right	corner	of	your	screen	you	will	get	a	list	of	all	indicators	you	have	currently	on	the	chart.	I	have	three	of	them	because	I	have	added	EMA,	RSI	and	MACD	indicators	on	the	MT4.	Now	you	need	to	click	on	the	Trash	icon	in	the	top	right
corner	to	get	the	checkbox	next	to	each	indicator.	Image	below	shows	you	what	that	looks	like	in	an	MT4	mobile.	I	will	select	the	RSI	and	MACD	indicator	to	remove	them	from	the	chart.	If	you	want	you	can	select	only	one	indicator	or	you	can	select	all	of	them	to	remove	them	from	the	chart.	After	selecting	which	indicator	to	remove	you	need	to	click
on	the	Trash	icon	in	the	top	right	corner	and	selected	indicators	will	be	removed.	Now	I	have	only	one	indicator	left,	EMA.	To	get	out	from	this	menu	you	need	to	click	on	the	arrow	pointing	to	the	left	in	the	top	left	corner.	Doing	that	you	will	go	back	to	the	chart	with	only	one	indicator	on	it.	This	is	it.	Simple	process	of	removing	indicators	from	the
MT4	mobile.	I	hope	this	guide	has	helped	you.	If	you	have	any	questions	feel	free	to	ask.	If	you	want	to	remove	the	last	one	indicator	on	MT4	mobile	you	simply	repeat	the	same	process.	To	add	a	custom	indicator	on	MT4	mobile	is	not	possible	because	creators	of	MT4	mobile	version	did	not	plan	to	make	it	available.	One	of	the	options	to	add	a	custom
indicator	is	to	use	a	tablet	with	windows	and	install	MT4	on	it.	That	way	you	will	have	the	same	version	like	on	the	PC	where	you	will	be	able	to	install	custom	indicators.	The	same	way	you	add	just	one	indicator.	Look	at	the	drop	down	menus	at	the	top	left	corner	of	your	window,	click	on	Insert	->	Indicators	->	Trend	->	Moving	Average.	If	you	want
to	add	a	second	Moving	Average	you	repeat	the	same	actions,	but	you	obviously	change	the	properties	of	the	second	MA.	You	do	the	same	with	any	other	indicator	you	want	to	add	to	your	chart.	You	can	put	as	many	indicators	as	you	want	in	the	same	chart,	until	it's	lit	up	like	a	Christmas	tree.	Still,	I'd	recommend	putting	few	enough	indicators	to
actually	see	the	chart.	Keep	in	mind	that	the	more	indicators	you	use,	the	bigger	the	chance	for	them	to	give	you	contradicting	signals,	so	it's	best	to	use	2-3	at	most.	Page	2	William	Roeder	2020.10.03	14:57	#17			Don't	Hijack	other	threads	for	your	off-topic	post.	Next	time,	make	your	own,	new,	thread.	MAs	work	because	they	just	need	one	series.
Ichimoku	is	based	on	[Max(H)	-	Min(L)]/2.	Can't	be	done.	Anyone	can	please	advice	Off-topic	posts	help	fixing	an	error	Page	3	William	Roeder:	No	such	thing	as	a	“Indicators	List.”	There	is	the	Insert	→	Indicators	popup	and	the	Navigator	Window.	You	drag	from	the	latter.						How	To	Ask	Questions	The	Smart	Way.	2004											Be	precise	and
informative	about	your	problem	I	believe	we	are	seeing	different	things.	EDIT:	Images	appear	while	editing	but	they	disappear	when	I	post	...	trying	to	find	a	way	to	put	here	(please	wait	until	final	edit).EDIT:	Only	managed	to	attach	Images.	I	do	not	know	how	to	put	them	visible	without	having	to	open	the	attachments...	Apologies.What	I	see	when
adding	a	new	indicator	on	the	chart:	1.	(select	from	the	available	Indicators	list)MainMenu	->	Insert	->	Indicators	->	Oscilators	->	RSI	(Example)	2.	(set	the	parameters	of	the	indicator)	3.	(indicator	added	on	chart,	extra	window)	Extra	window	appears	on	the	lower	part	of	the	Chart.	I	cannot	drag	anything	into	it.	Now,	if	I	want	to	change	the	Indicator
parameters	I	go	here:	4.	(select	from	active	indicators)MainMenu	->	Charts	->	Indicators	List	5.	(Indicators	List	pops	up)I	cannot	drag	or	change	window	on	any	indicator	that	I	put	here	(even	if	same	scale	of	values).	What	am	I	doing	wrong	here?	Thanks.	--	AC	Hello	everybody,	does	anybody	know	how	to	load	two	or	more	indicators	on	MT4	in	one
indicator	window?	If	i	ad	an	aditional	indicator	to	the	chart,	a	new	indicator	window	is	opened-but	how	can	i	load	an	aditional	indicator	overlapping	with	another	indicator	in	one	window?	(	this	happened	automatically	on	my	mobile	phone	MT4	when	i	loaded	more	indicators,	fortunately	the	intersection	of	those	two	indicators	seems	to	create	good
entry	signals,	so	i	want	to	have	the	same	constelation	on	my	laptop,	Thanks!	Just	click	on	the	second	indicator	and	drag	it	into	the	open	indicator	window.	Thanks,	but	how	should	this	work-because	when	i	click	menue-insert-indicator-choose	an	indicator	the	indicator	automatically	is	in	a	new	window.	It	is	not	possible	to	drag	an	indicator	from	the
menue	in	a	window	or	from	one	window	in	another	window?	First	-	“View”,	then	choose	“Navigator”.	Now	with	no	indicator	window	open	-	just	the	chart/price	-	select	one	indicator,	it	will	then	appear	at	the	bottom	of	the	MT4	chart	in	a	window	of	it’s	own.	Now	select	a	second	indicator	(left	click	-keep	the	mouse	button	down	and	drag	over	to	the
indicator	window	at	the	bottom	-	the	second	indicator	will	now	open	in	that	same	window.	1	Like	Thats	great,	it	works,	Thanks	a	(standard)	lot!	1	Like	The	benefit	of	MT4	and	MT5	is	that	they	can	quickly	and	easily	be	used	on	many	different	devices	including	Android,	iPhone	and	Mac.	The	mobile	platforms	have	over	30	indicators	that	can	be	used	on
both	the	MT4	/	MT5	Android	and	iPhone.	This	post	looks	at	the	available	indicators	in	the	MT4	/	MT5	android	and	iPhone	platforms	as	well	as	how	to	connect	your	account	and	start	using	them.	MT4	/	MT5	Android	and	iPhone	Trading	The	Android	and	iPhone	MT4	and	MT5	platforms	come	with	a	range	of	features	that	include;		Control	over	your
trading	accounts	along	with	syncing	accounts.	Mobile	trading	from	anywhere	at	any	time.	All	order	types	are	available.	Check	your	trading	history.	Use	three	different	charts	including;	bars,	Japanese	candlesticks	and	line	charts.	Range	of	time	frames	from	one	minute	to	one	month.	30	technical	indicators.	Ability	to	check	news.	Free	chat	and	email.
Indicators	Available	on	MT4	Android	and	iPhone	MT4	offers	you	a	wide	range	of	indicators	on	your	Android	and	iPhone.	These	include;	Accelerator	Oscillator	Accumulation/Distribution	Alligator	Average	Directional	Movement	Index	Average	True	Range	Awesome	Oscillator	Bears	Power	Bollinger	Bands	Bulls	Power	Commodity	Channel	Index
DeMarker	Envelopes	Force	Index	Fractals	Gator	Oscillator	Ichimoku	Kinko	Hyo	MACD	Market	Facilitation	Index	Momentum	Money	Flow	Index	Moving	Average	Moving	Average	of	Oscillator	On	Balance	Volume	Parabolic	SAR	Relative	Strength	Index	Relative	Vigor	Index	Standard	Deviation	Stochastic	Oscillator	Volumes	Williams	Percent	Range
Indicators	Available	on	MT5	Android	and	iPhone	Similar	to	MT4,	MT5	offers	you	a	wide	range	of	indicators	on	your	Android	and	iPhone.	These	include;	Moving	Average	Force	Index	Accelerator	Oscillator	Bollinger	Bands	Momentum	Awesome	Oscillator	Average	Directional	Movement	Index	Moving	Average	of	Oscillator	Gator	Oscillator	Envelopes
Relative	Strength	Index	Alligator	Ichimoku	Kinko	Hyo	Relative	Vigor	Index	Market	Facilitation	Index	Standard	Deviation	Williams	Percent	Range	Parabolic	SAR	Average	True	Range	Accumulation/Distribution	Fractals	Bears	Power	Money	Flow	Index	MACD	Bulls	Power	On	Balance	Volume	Stochastic	Oscillator	Commodity	Channel	Index	Volumes
DeMarker	How	to	Add	Indicators	on	Android	and	iPhone	Similar	to	using	an	indicator	on	your	Metatrader	PC	platform,	an	indicator	can	be	placed	directly	on	your	chart	or	attached	below	(for	example	when	using	an	oscillator	indicator).	The	first	thing	you	need	to	do	is	either	create	a	free	account	inside	the	Metatrader	mobile	platform	or	connect	your
existing	account.	NOTE:	If	you	do	not	yet	have	a	free	MT4	or	MT5	account	you	can	get	one	here.	To	connect	your	existing	account	that	you	have	created	through	your	broker	follow	these	instructions;	Open	your	MT4	/	MT5	mobile	platform.	Click	on	‘settings’	and	‘manage	accounts’.	Click	on	the	+	symbol	to	add	your	existing	account.	Choose	‘login	to
existing	account’.	Search	for	your	broker	and	then	select	them.	Enter	your	login	and	password	and	then	sign	in.	To	add	indicators	to	your	mobile	trading	platform	follow	these	instructions;	Open	your	MT4	or	MT5	mobile	platform.	Open	the	chart	you	wish	to	apply	the	indicator	to.	Select	the	symbol.	You	will	then	have	two	options.	You	can	either	add
an	indicator	to	the	main	chart	or	to	the	indicator	window.	Select	the	symbol	and	choose	from	the	range	of	indicators.	Select	the	indicators	parameters	you	wish	to	use	and	hit	done	to	apply	it.	How	to	Remove	Metatrader	Mobile	Indicators	To	delete	any	indicators	you	no	longer	want	applied	first	hit	thesymbol.	Select	the	delete	symbol	and	you	will	be
able	to	tick	the	indicators	you	want	to	remove.	Once	the	indicators	you	want	deleted	are	selected	hit	the	delete	button	again	and	they	will	be	removed.	How	to	Modify	Indicators	To	modify	and	change	the	parameters	for	any	indicators	you	already	have	applied	first	hit	the	indicator	button	to	bring	up	your	indicators.	Select	the	indicator	you	wish	to
customize	and	you	will	be	presented	with	the	options	you	can	change.	Make	your	changes	and	select	‘done’.	How	to	Use	Custom	Metatrader	Indicators	in	Android	and	iPhone	At	this	point	in	time	adding	or	using	custom	indicators	such	as	the	1,2,3	pattern	indicator	or	auto	Fibonacci	indicator	is	not	a	built	in	function.	The	most	common	workaround
that	traders	use	to	have	these	types	of	indicators	available	is	by	either	using	a	Microsoft	based	tablet	or	mirroring	their	computer	to	their	phone.	Whilst	using	a	Microsoft	tablet	that	allows	the	full	functions	of	Metatrader	is	an	easier	option,	it	also	defeats	the	purpose	of	mobile	trading.	When	setting	up	mirroring	you	are	able	to	access	your	full	suite	of
Metatrader	tools	that	your	computer	is	running	including	all	of	the	custom	indicators.	Read	how	to	set	up	remote	computer	mirroring	here.	As	a	trader,	understanding	the	market	and	properly	analyzing	price	movements	is	crucial	for	making	informed	trading	decisions.	One	way	to	gain	better	insights	into	the	market	is	by	using	indicator	windows	in
MT4.Indicator	windows	are	separate	panes	on	the	MT4	platform	that	display	various	technical	indicators,	such	as	moving	averages,	oscillators,	or	trend	lines.	Combining	these	indicator	windows	can	help	traders	identify	trends,	reversals,	and	potential	entry	or	exit	points.Table	Of	ContentsIn	this	step-by-step	guide,	we	will	explain	how	to	combine
indicator	windows	in	MT4.	By	following	these	instructions,	you	will	be	able	to	create	a	comprehensive	view	of	the	market,	enhancing	your	trading	strategy	and	decision-making	process.Before	we	dive	into	the	process,	make	sure	you	have	MT4	installed	on	your	computer	and	have	chosen	the	indicators	you	want	to	include	in	your	analysis.	Once	you
are	ready,	let’s	get	started!What	is	MT4	and	how	does	it	work?MT4,	or	MetaTrader	4,	is	a	popular	trading	platform	used	by	traders	worldwide.	It	provides	a	user-friendly	interface	for	online	trading	in	various	financial	markets,	including	Forex,	Commodities,	and	Indices.MT4	works	by	connecting	traders	to	their	chosen	broker’s	trading	servers
through	the	internet.	Traders	can	download	and	install	the	MT4	software	on	their	computer	or	use	the	web	version,	depending	on	their	broker’s	offerings.Once	connected	to	the	broker’s	trading	servers,	traders	can	access	real-time	market	quotes,	analyze	charts,	place	trades,	and	manage	their	accounts.	MT4	provides	a	wide	range	of	technical
indicators	and	charting	tools	that	traders	can	use	to	analyze	price	movements	and	make	informed	trading	decisions.Traders	can	customize	their	MT4	platform	by	adding	and	arranging	indicator	windows	according	to	their	preferences.	These	indicators	can	help	traders	identify	potential	trade	opportunities	and	determine	entry	and	exit	points.MT4	also
supports	the	use	of	automated	trading	systems,	known	as	Expert	Advisors	(EAs),	which	can	execute	trades	on	behalf	of	the	trader	based	on	predefined	rules	and	strategies.In	summary,	MT4	is	a	versatile	trading	platform	that	provides	traders	with	the	necessary	tools	to	analyze	markets,	place	trades,	and	manage	their	accounts.	It	is	widely	used	due	to
its	user-friendly	interface,	extensive	charting	capabilities,	and	support	for	automated	trading.Understanding	the	MT4	trading	platformThe	MT4	trading	platform	is	a	popular	choice	for	both	beginner	and	experienced	traders	due	to	its	user-friendly	interface	and	comprehensive	range	of	features.	Here	are	some	key	aspects	to	understand	about	the	MT4
trading	platform:1.	User	Interface:	The	MT4	platform	offers	a	simple	and	intuitive	user	interface,	making	it	easy	for	traders	to	navigate	and	execute	trades.	The	main	screen	consists	of	multiple	windows,	including	the	market	watch,	chart,	navigator,	and	terminal	windows.Read	Also:	Discover	the	IFA	Business	Fee:	All	You	Need	to	Know2.	Charts:	The
platform	provides	a	variety	of	chart	types,	such	as	line,	bar,	and	candlestick	charts,	which	allow	traders	to	analyze	price	movements	over	different	timeframes.	Traders	can	also	customize	chart	settings,	apply	technical	indicators,	and	add	trendlines	to	make	informed	trading	decisions.3.	Indicators:	MT4	offers	a	wide	range	of	built-in	technical
indicators,	such	as	moving	averages,	Bollinger	Bands,	and	MACD,	which	can	be	applied	to	charts	to	identify	potential	entry	and	exit	points.	Traders	can	also	create	their	own	custom	indicators	using	MQL4	programming	language.4.	Expert	Advisors:	MT4	allows	traders	to	automate	their	trading	strategies	by	using	Expert	Advisors	(EAs).	EAs	are
custom	programs	that	can	analyze	market	conditions,	place	trades,	and	manage	positions	automatically	based	on	predefined	rules.	Traders	can	either	create	their	own	EAs	or	use	existing	ones.5.	Order	Execution:	The	MT4	platform	provides	various	order	types,	such	as	market	orders,	limit	orders,	and	stop	orders,	allowing	traders	to	execute	trades
based	on	their	preferred	strategy.	Traders	can	also	set	take	profit	and	stop	loss	levels	to	manage	their	risk.6.	Historical	Data:	MT4	provides	access	to	historical	price	data,	allowing	traders	to	backtest	their	trading	strategies	and	analyze	past	market	movements.	This	data	can	be	used	to	identify	patterns,	test	different	approaches,	and	improve	trading
performance.7.	Mobile	Trading:	MT4	is	available	as	a	mobile	application,	allowing	traders	to	access	their	trading	accounts	and	execute	trades	on	the	go.	The	mobile	platform	offers	similar	features	to	the	desktop	version,	ensuring	flexibility	and	convenience	for	traders.By	understanding	the	various	features	and	functionalities	of	the	MT4	trading
platform,	traders	can	effectively	analyze	the	markets,	implement	their	trading	strategies,	and	navigate	the	dynamic	world	of	online	trading.What	are	indicator	windows	in	MT4?In	MT4,	indicator	windows	refer	to	the	separate	sub-windows	that	display	various	technical	indicators	on	top	of	the	main	price	chart.	These	windows	provide	traders	with
additional	information	and	analysis	to	make	more	informed	trading	decisions.Read	Also:	Do	Forex	Trading	Robots	Really	Work?	Unveiling	the	TruthIndicator	windows	are	independent	from	the	main	chart	and	can	be	customized	to	display	different	indicators,	such	as	moving	averages,	oscillators,	trend	lines,	volume,	and	more.	Traders	can	choose	to
add	or	remove	indicators	in	these	windows	based	on	their	trading	strategies	and	preferences.The	indicator	windows	are	positioned	below	the	main	price	chart	and	are	organized	in	a	vertical	manner.	Each	indicator	window	has	its	own	scale	and	axis	to	display	the	values	of	the	indicator	being	used.	Traders	can	adjust	the	scale	and	customize	the
appearance	of	these	windows	to	suit	their	needs.Indicator	windows	provide	a	visual	representation	of	market	data	and	help	traders	identify	trends,	patterns,	and	potential	entry	or	exit	points.	By	combining	multiple	indicators	in	different	windows,	traders	can	create	a	comprehensive	analysis	and	gain	a	deeper	understanding	of	market
conditions.Advantages	of	using	indicator	windowsDisadvantages	of	using	indicator	windowsEnables	simultaneous	display	of	multiple	indicatorsMay	clutter	the	chart	and	make	it	difficult	to	interpretAllows	traders	to	customize	indicator	settingsCan	lead	to	over-analyzing	and	confusionProvides	additional	insights	for	trading	decisionsRequires
understanding	of	different	indicators	and	their	interpretationsOverall,	indicator	windows	in	MT4	serve	as	valuable	tools	for	traders	to	enhance	their	technical	analysis	and	improve	their	trading	strategies.	By	utilizing	these	windows	effectively,	traders	can	gain	a	better	understanding	of	market	dynamics	and	make	more	informed	trading
decisions.FAQ:What	is	MT4?MT4	stands	for	MetaTrader	4,	which	is	a	popular	trading	platform	used	by	forex	traders	around	the	world.How	can	I	combine	indicator	windows	in	MT4?To	combine	indicator	windows	in	MT4,	you	can	follow	the	step-by-step	guide	provided	in	the	article.	It	explains	how	to	open	multiple	indicator	windows	in	the	platform
and	adjust	their	placement.Why	would	I	want	to	combine	indicator	windows	in	MT4?Combining	indicator	windows	in	MT4	allows	you	to	have	a	more	comprehensive	view	of	the	market.	By	placing	multiple	indicators	in	different	windows,	you	can	analyze	different	aspects	of	the	market	simultaneously	and	make	better	trading	decisions.Can	I	customize
the	appearance	of	the	indicator	windows	in	MT4?Yes,	you	can	customize	the	appearance	of	the	indicator	windows	in	MT4.	The	platform	offers	various	customization	options,	such	as	changing	the	color,	line	style,	and	thickness	of	the	indicators,	to	suit	your	preferences.Is	it	possible	to	save	the	layout	of	indicator	windows	in	MT4?Yes,	you	can	save	the
layout	of	indicator	windows	in	MT4.	This	allows	you	to	quickly	load	your	preferred	configuration	of	indicator	windows	whenever	you	open	the	platform.What	is	MT4?MT4	stands	for	MetaTrader	4,	which	is	a	widely	used	trading	platform	for	forex	and	CFDs.	It	allows	traders	to	analyze	financial	markets,	perform	technical	analysis,	and	execute
trades.See	Also:	William	Roeder:	No	such	thing	as	a	“Indicators	List.”	There	is	the	Insert	→	Indicators	popup	and	the	Navigator	Window.	You	drag	from	the	latter.						How	To	Ask	Questions	The	Smart	Way.	2004											Be	precise	and	informative	about	your	problem	I	believe	we	are	seeing	different	things.	EDIT:	Images	appear	while	editing	but	they
disappear	when	I	post	...	trying	to	find	a	way	to	put	here	(please	wait	until	final	edit).EDIT:	Only	managed	to	attach	Images.	I	do	not	know	how	to	put	them	visible	without	having	to	open	the	attachments...	Apologies.What	I	see	when	adding	a	new	indicator	on	the	chart:	1.	(select	from	the	available	Indicators	list)MainMenu	->	Insert	->	Indicators	->
Oscilators	->	RSI	(Example)	2.	(set	the	parameters	of	the	indicator)	3.	(indicator	added	on	chart,	extra	window)	Extra	window	appears	on	the	lower	part	of	the	Chart.	I	cannot	drag	anything	into	it.	Now,	if	I	want	to	change	the	Indicator	parameters	I	go	here:	4.	(select	from	active	indicators)MainMenu	->	Charts	->	Indicators	List	5.	(Indicators	List
pops	up)I	cannot	drag	or	change	window	on	any	indicator	that	I	put	here	(even	if	same	scale	of	values).	What	am	I	doing	wrong	here?	Thanks.	--	AC	Page	2	William	Roeder	2020.10.03	14:57	#17			Don't	Hijack	other	threads	for	your	off-topic	post.	Next	time,	make	your	own,	new,	thread.	MAs	work	because	they	just	need	one	series.	Ichimoku	is	based
on	[Max(H)	-	Min(L)]/2.	Can't	be	done.	Anyone	can	please	advice	Off-topic	posts	help	fixing	an	error	In	forex	trading,	to	be	successful	you	need	to	support	tools	such	as	charts,	technical	indicators,	etc.	These	technical	tools	will	help	you	predict	future	price	action	and	find	good	opportunities	to	trade	and	make	trading	decisions	at	the	right	time.	In
addition	to	the	indicators	provided	on	mt4	mobile,	you	can	add	other	custom	indicators	to	improve	the	efficiency	of	analysis	and	trading.	This	article	will	show	you	how	to	add	custom	indicators	to	the	MOBILE	MT4	platform	(iPhone,	iPad	and	Android).	When	do	I	need	to	install	custom	indicators?	An	indicator	is	a	technical	tool	that	provides	crucial
market	states	on	a	chart	and	helps	predict	future	price	activity.	When	trading	on	MetaTrader	4,	you	will	be	provided	with	several	specific	indicators	pre-installed	on	the	platform.	You	can	use	them	to	perform	chart	analysis.	However,	such	instruments	cannot	in	many	cases	meet	the	needs	of	all	investors.	Therefore,	you	need	to	know	how	to	accurately
add	custom	indicators	from	custom	sources	to	meet	your	needs.	So,	how	do	you	add	custom	indicators	to	MT4?	Is	it	too	complicated	to	use	custom	indicators	in	conjunction	with	the	existing	tools	on	the	platform?	MetaTrader	is	programmed	with	the	MQL4	language	that	allows	you	to	freely	add	any	MT4	compatible	indicator	to	the	platform	in	less
than	a	minute!	In	addition,	you	can	install	as	many	indicators	as	you	want	to	create	a	new	strategy	or	update	an	existing	one.	In	this	guide,	we’ve	thoroughly	explained	how	to	add	the	indicator	to	all	versions	of	MT4	mobile	software,	including	iPhone	(iOS)	and	Android.	How	to	add	custom	indicators	to	MT4	iPhone?	MT4	does	not	allow	the	addition	of
custom	indicators	in	the	iOS	version.	However,	you	can	still	install	custom	indicators	via	iPhone	or	iPad	via	remote	connections	to	your	PC.	Specifically,	the	steps	are	as	follows:	Step	1:	Device	Settings	allows	you	to	connect	your	mobile	device	to	your	PC	remotely.	Then,	by	connecting	to	your	computer,	you	will	have	full	access	to	the	desktop	version
of	MT4	and	will	be	able	to	use	custom	MQL4	indicators	from	any	iOS	device.	The	best	iOS	apps	you	can	use	for	remote	desktop	connection	are:	TeamViewer	Remote	Desktop	LogMeIn	Method	GoToMyPC	JumpDesktop	Step	2:	Open	MT4	(desktop)	>	Go	to	Navigator	>	double-click	Indicators	to	expand	the	list	of	indicators.	Step	3:	Double	click	on	the
indicator	you	want	to	add	to	the	chart	and	press	OK.	This	way,	you	will	be	able	to	add	and	use	MQL4	custom	indicators	in	both	MT4	and	MT5	platforms	from	your	iOS	device.	How	to	add	custom	indicators	to	Android	MT4?	Like	iPhone	or	iPad,	MT4	also	does	not	allow	you	to	add	custom	indicators	to	Android	devices.	To	add	custom	indicators	to	MT4
on	Android,	follow	these	steps:	Step	1:	Connect	your	Android	phone/tablet	to	your	PC	using	the	remote	desktop	app.	The	Android	apps	you	can	use	to	connect	to	a	remote	computer	are:	AnyDesk	Remote	Control	TeamViewer	Remote	Control	Chrome	Remote	Desktop	Remote	Desktop	8	(Microsoft)	Splashtop	Personal	Remote	PC	Step	2:	Click	indicators
>	Go	to	Customization	>	Select	the	custom	indicator	you	want	to	add	to	MT4:	Step	3:	If	necessary,	change	the	custom	settings	of	the	indicator	in	the	properties	window	and	click	OK.	You	will	see	that	the	custom	indicator	has	been	added	to	your	chart	and	starts	working	at	the	same	time.	It	can	be	said	that,	in	perfect	trading	conditions,	you	can	need
one	of	the	indicators	available	on	MT4	and	trade	on	the	signals	that	the	indicator	gives.	However,	the	reality	is	that	the	market	always	has	unexpected	fluctuations,	so	many	traders	want	to	look	for	custom	indicators	or	combine	different	indicators	to	get	more	accurate	trading	signals.	Indicators	in	MT4	and	MT5	platforms	are	beneficial	for	the
majority	of	traders.	Indicators	can	remove	noise	from	the	data,	point	to	essential	breakouts,	and	show	divergence.We	have	default	indicators	in	MT4	and	MT5	Android	apps,	which	is	enough	for	most	traders.	However,	one	of	the	main	questions	is	whether	we	can	add	custom	indicators	to	the	MT4	app.You	can	not	install	custom	indicators	on	the	MT4
Android	platform	because	Android	and	iOs	platforms	do	not	allow	changing	the	app’s	code,	and	any	preprogramming	of	the	installed	app	is	not	allowed.	However,	you	can	install		Windows	MT4	on	VPS,	add	custom	indicators,	and	access	it	with	an	Android	phone.Trillion	Dollar	Club	-	Invest	&	Trade	Stocks,	Crypto,	ForexExpert	advisors,	scripts,	and
indicators	can	not	be	added	to	the	app,	only	to	the	MT4	or	MT5	desktop	platform.See	below	my	video	that	I	made	on	youtube	related	to	this	topic:How	to	install	the	MT4	App	on	VPS	and	add	custom	indicators?Obtain	a	Free	VPS	from	Your	Broker:Many	brokers	offer	their	clients	free	VPS	hosting,	especially	those	who	maintain	a	certain	account
balance	or	trading	volume.To	get	a	free	VPS,	contact	your	broker’s	support	or	check	their	website	for	information	on	the	criteria.Once	you	are	eligible,	the	broker	will	usually	provide	details	on	accessing	the	VPS.VPS	Access	Details:After	you’ve	obtained	the	VPS,	the	broker	(or	the	VPS	provider)	should	provide	you	with	the	following	information:IP
Address	of	the	VPS.Username	(often	“Administrator”	for	Windows	servers).Password.Install	MT4	on	the	VPS:Connect	to	your	VPS	using	a	Remote	Desktop	Client	on	your	computer.	You	can	use	the	built-in	“Remote	Desktop	Connection”	tool	for	Windows.Once	connected,	open	a	browser	on	the	VPS,	go	to	your	broker’s	website	or	the	official	MT4
website,	and	download	the	MT4	platform.Install	MT4	as	you	would	on	a	regular	computer.Add	Custom	Indicators	to	MT4	on	VPS:If	you	have	the	custom	indicator	files	(.mq4	or	.ex4)	on	your	local	computer,	you	can	transfer	them	to	the	VPS	by	copying	and	pasting	them	over	the	remote	desktop	connection	or	using	a	file	transfer	tool.Once	transferred,
open	MT4	on	the	VPS.Navigate	to	“File”	>	“Open	Data	Folder”	>	“MQL4”	>	“Indicators.”Paste	the	custom	indicator	files	in	this	folder.Restart	MT4	to	ensure	the	custom	indicators	are	loaded.Connect	from	Android	Phone	using	Remote	Desktop:On	your	Android	phone,	go	to	the	Google	Play	Store	and	download	an	app	called	“Microsoft	Remote
Desktop”	or	any	other	remote	desktop	app	you	prefer.Once	installed,	open	the	app	and	add	a	new	connection.	Enter	the	IP	address,	username,	and	password	provided	by	your	broker	for	the	VPS.Connect	to	the	VPS.	Once	connected,	you	will	see	the	VPS’s	desktop	and	can	open	MT4	from	there.Access	and	Use	MT4	with	Custom	Indicators	on
Android:You	can	access	the	MT4	platform	installed	on	the	VPS	with	the	remote	desktop	app.	It’s	like	accessing	a	computer	remotely.You	can	open	charts,	apply	custom	indicators,	and	trade	as	you	would	on	a	desktop	version	of	MT4.Note:	Using	MT4	over	a	remote	connection	on	the	phone	might	be	a	bit	clunky	due	to	the	small	screen	size.	It’s	often
used	for	monitoring	and	quick	tasks,	but	for	in-depth	analysis,	using	a	tablet	or	a	computer	is	recommended.Trillion	Dollar	Club	-	Invest	&	Trade	Stocks,	Crypto,	ForexManage	$300	000	Account.	Earn	as	trader!Also,	always	ensure	your	VPS	has	a	reliable	connection	and	keep	all	software,	including	MT4,	updated	for	security	reasons.Trillion	Dollar
Club	-	Invest	&	Trade	Stocks,	Crypto,	ForexYou	can	add	custom	indicators	on	the	MT4	desktop	easily,	like	in	this	image	below:Manage	$300	000	Account.	Earn	as	trader!Will	we	be	able	to	install	custom	indicators	in	MT4	Android	in	the	future?No.	Developers	in	the	MetaTrader	space	realize	that	professional	traders	only	use	expert	advisors,	custom
indicators,	and	scripts	on	Desktop	Metatrader	platforms.	The	mobile	device	is	for	monitoring	and	sometimes	for	closing	or	opening	new	positions.	Current	indicators	are	entirely	enough	for	trading.However,	some	brokers	plan	to	add	new	indicators	in	the	trading	app,	so	in	the	future,	we	will	see	more	and	more	indicators,	so	there	will	be	no	need	to
add	custom	indicators	from	our	side.	Trillion	Dollar	Club	-	Invest	&	Trade	Stocks,	Crypto,	Forexlink	to	Delta	Volume	Flow	and	Low	Volume	Profile	Zones	in	Futures	Tradinglink	to	Rising	Japanese	Inflation	Signals	Yen	Strength:	Is	a	USDJPY	Downtrend	Coming?	Al	W	2009.12.03	04:52	#3			Sorry,	but	it	IS	possible.	How	meaningful	is	really	up	to	the
person	experimenting.	The	moving	average	adapts	to	the	indicator	it	is	averaging.	So	it	doesnt	care	what	scale	its	on,	it	just	averages.	Very	simple.	I	did	forget	to	mention	that	after	you	drag	the	moving	average	onto	the	RSI(the	only	way	the	combination	will	work),	you	must	change	the	portion	that	says	"apply	to:"	instead	of	close,	change	it	to
Previous	indicators	data	or	First	Indicator	data.	Moving	Average	Atr	For	"Solar	wind"	believers	Page	2	circlesquares:	Sorry,	but	it	IS	possible.	How	meaningful	is	really	up	to	the	person	experimenting.	The	moving	average	adapts	to	the	indicator	it	is	averaging.	So	it	doesnt	care	what	scale	its	on,	it	just	averages.	Very	simple.	I	did	forget	to	mention
that	after	you	drag	the	moving	average	onto	the	RSI(the	only	way	the	combination	will	work),	you	must	change	the	portion	that	says	"apply	to:"	instead	of	close,	change	it	to	Previous	indicators	data	or	First	Indicator	data.	Sorry,	but	this	is	not	possible	on	my	Mt4-platforms	(	Forex4you-broker,	GoMarkets-broker	).	The	the	apply	to	field	does	not	show
"Previous	indicators"	or	"First	indicator".	It	only	shows	Close,	Open,	High,	Low	etc.	but	nowhere	it	shows	the	Previous	indicator	or	First	indicator.	This	it	is	impossible	for	me	to	have	the	MA	on	the	same	chart-window	as	the	RSI.	It	looks	like	on	some	Mt4-platforms	this	is	different,	but	I	have	no	luck.	What	broker	do	you	use	?	Maybe	I	can	download
the	platform	and	copy	the	Moving	Average	indicator	from	there.	Thanks	Taskin	Osman	2009.10.27	21:11	#1			#property	indicator_separate_window	instead	of	#property	indicator_chart_window	but	you	cannot	add	different	indicators	to	same	seperate	window	unless	you	combine	all	indicators	to	1	indicator	script.	Check	Alligator	indicator	and	simply
change	its	property	and	you	will	see	3	ma	on	seperate	window	fx1.net


